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Chapter 1: Introduction

1.1 Introducing the IGSS Driver Test module, T7T

The purpose of T7T is to monitor the communication between IGSS and the PLC driver.
This is very useful for testing and troubleshooting the PLC communication.

T7T can also be used to read data from a PLC.

T7T has a very simple user interface which looks like this.

T7T Driver Test Application E||E|g|
Packet Count Statistics
Packets to driver: 4
Packets from driver: 32
Error packets: 1
Data group Hes: O top: Log []

Last Data Packet
Station Mo 0 Time stamp | 20070214 10:55:44:865

Driver id Mode number  Data group Wiard offset
34 0 01 0
oooo

Program Information

Logging off... -
Stopping monitor. De i still running...

DiZ iz running. T7T is active...

Logging anto driver interface. . w

Stop Test
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Chapter 2: Functionality

2.1 Data group Hex

In the T7T main window, choosing Data group hex changes the Data group in Last Data Packet to be
displayed in hexadecimal.

TIT Driver, Test Application E||E|E|
Packet Count Statistics
Packets to driver: 4
Packets from driver: 732
Error packets: 1
Data group Hes o top: Log: []

Last Data Packet
Station Mo 0 Time statnp | 2007024 4 10:58: 44565

Diriver i Mode number  Data group Wiord offset
34 0 :1 0
Qonog

Program Information

Logging off... Y
Stopping monitor. Do is still running...

DC i running. T7T is active...

Logging anto driver interface. .. -

Stop Test

2.2 Filter

1. If you wish to filter the shown data, click Filter Off in the main T7T window.
2. Inthe Filter Input dialog box, you can choose which data you want to see.

3. Inthis example, we are looking at data from Driver Id 34 (Generic TCP/IP Driver) and
Node number 0.

4, Choose Filter Off to reset to default values.
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Filter Input g|§|®

Sy O [voin
Diveer id 34

MNode nurmber # Object
Data group / Atom Ol Yol

‘wiord offset L] |vo
Wiard count ] |valn

Data[0] 1 |voiD
Only error and bad F
quality packets SIL0S

| Fiterot | | ok |

2.3 Log

Choose Log to write the monitored data to a log file. The default name of the log file is TZT.SCN and will
reside in the configuration's report folder.

The log file cannot be read in a text editor, but can be read by using the IGSS utility prscan.

T7T Driver Test Application |Z||§|Pz|
Packet Court Statistics
Packets to driver: 0
Packets from driver: 210
Error packets: 1]
Data group Hex: |:| ontogp: |:|-

Last Data Packet
Station Mo 0 Time stamp | 20070243 150927614

Diriver i Mode number  Data group Wiord offset
34 0 1 0
135355

Program Information

MOT connected =1 0.0.0.012111.0.0.11 s
MOT connected =1 000010 111.0011 B
DC iz running. TYT is active...

Logging anto driver interface. . ;

Stop Test
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2.4 Monitoring of PLC communication

1. Click Start Test to start the monitoring of the PLC communication.

Result: The application will connect to the driver(s) activated in the System Configuration program.
In the Last Data Packet area, you will see the following information:

o Station number

e Time stamp

o Driver ID (found in the System Configuration program)
o Node number

o Data group

o Word offset

for the last packet sent to IGSS.

T7IT Driver, Test Application

Packet Count Statistics
Packets to driver: Fesat Stalsics

Packetz from driver: Lazt errar packet

11

Error packets: Send packet

Data group Hese [ On top: Log [ Fitter Crff

Program Information

DC i running. T7T is active...
Logging onto driver interface...

Start Test [ Stop Test

S
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2.50n top

Choosing On top changes the T7 window behavior to stay on top of other windows.

T7IT Driver, Test Application

Packet Court Statistics
Packets to driver: n Reset Stalistics
Packets from driver: 2 Last error packet
Etror packets: o Send packet
[Crat Hex: ontogp: i

a group Hex: [ lontop: [#] Log: [] Fitter (it

Last Data Packet
Station Mo 0 Time stamp | 2007024 4 10015 26:543

Driver id Mode number Data group Wiord offaet
34 0 1 0

el

Program Information

DiZ iz running. T7T is active...
Logging anto driver interface. .

’ Stop Test

2.6 Reading data from a PLC

T7T can also be used to read part of the memory in a PLC. To be able to do that, it is required to follow the
following procedure:

1. Before you can read the memory in the PLC, you must start the driver. This is simply done by start-
ing the project from the IGSS Starter.

Activate T7T and click the Start Test button.
Then click Stop Test.
The registry key required for reading the memory in the PLC has now been created.

Open the Windows Registry Editor - regedit.exe - by selecting Start -> Run > Regedit.exe.

o vk W N

Choose the key HKEY_CURRENT_USER\Software\7-Technologies\IGSS32\V8.00.00\
7ttcp_HKLM\Test.
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7. Double click NumberOfSrecs and enter 1.

8.

10.

In T7T, click the Start Test button to read the specified memory area in the PLC.

£:" Registry Editor

File Edit “ew Fawvorites Help
= =} My Computer || Mame

- Tvpe
[ HKEY_CLASSES_ROOT ab](Default) REG_SZ
=[] HKEY_CLURRENT _LISER: BB numberofsrecs REG_DWORD

I:l AppEvents
I:l Carnman
[ Console
[ Contral Panel
I:l Enwironmment
[ Identities
[ kevboard Layout
[ Metwork:
I:l Prinkers
[ sessionInformation
=7 Software
s
=-_7] 7-Technologies
[ 7Flow
[ DxfzMap
=] Ias53z
[ v3.00.00
[ ve.00.00
= ¥7.00.00
[ 7r3oe4r_HeLM
[ 7rab_HeLm
[ 7TCML_HKLM
[ 7TOPC_HELM
[ 7Es7_HELM
[ 7ts7pea_HeLM
=-{_ Frtcp_HELM
=7 channelo
[ dialup
(1 noden
R 1=t I

My ComputeriHEEY _CURREMNT _USERSoftware! 7-Technologies 1G55321w 7. 00,0007 tkcp_HELMY Test

In the Registry Editor, press F5 to update the window. Click the + sign next to Test and choose
Srec0. Double click DataGroup and enter the value 1. Double-click Interval and enter the
value 10. Double-click Length and enter the value 1.

Double-click Node and enter the value 0. Double- click Offset and enter the value 1. The data
from the memory in the PLC is shown in the monitoring window of T7T.
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Packet Count Sttisti

T7T Driver Test Application ¥5.00.00.3325 ] ] |

Reset Statistics |

| [start DCA 1 mask 7
g B8 CELL . Monitoring packets. .
“f | Logging on to driver interface. ..

If you have multiple drivers in your configuration, the “Test” key in the “Registry Editor” will appear for
every driver activated.

2.7 Send packet

The T7T application can also be used to send data to a PLC.

1. If you want to use this functionality, start the application 7ttcpmon, which is a built-in soft PLC in
IGSS. The filename is 7ttcpmon.exe and it is located in the [IGSS InstallPath]\Gss folder.

2. Make an object in IGSS with 7TTCP as the driver, data type WORD and offset 0.
3. InT7T, click Send Packet.

In the Send Sequence Packet dialog box, enter the following:
o Station =0

e DriverID =34
The ID of the 7TTCP driver

e Node =0
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Data group = 1
Means data type is Word. Data group must be specified as 0 = Byte, 1 = Word, 2 = DWORD and 3
= FLOAT

Word Offset = 0
Length =1
Sequence start value = 100

Click Send and the main window of the TCP Monitor should now show

FROM IGSS: Index:1 Type:1 Word:00100 #0064

S5end Sequence Pac... |Z||E|[Z|

Statian

Drriveer id 34

Mode nurmber

Drata group
YWiord offzet

Length

Sequence start value

Cancel Send

N T | R | T ]
=
=

TCPMON  Support for B Nodes

0000 00000 #0000
0007 OMO0 #0064
0002 00000 #0000

0003 00000 #0000 OBYTE
0004 00000 #0000
0005 00000 #0000
0006 00000 #0000
0007 00000 #0000 () DWORD
0008 00000 #0000

0003 00000 #0000 (O FLOAT
0010 00000 #0000
0017 00000 #0000

ant D nanan_ HOnnn

FROM 1GSS: Index:1 Type:1 “Woord: 00700 #0064

Connected

OnTop
Active

DATAMODE

|2

(®)WORD

|
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Chapter 3: Reference and Lookup

3.1 Conventions in this Manual

The following typographical conventions are used:

Convention Description Example
User inter- When referring to labels and names
face ele- : . The Data Management tab.
in the user interface.
ment
. When the user has to type specific RIS e e T Lt Aol
Userinput | yjata in 1GSS
' Incoming flow in Tank 2
Module . . C
name When referring to a module in IGSS Open the Definition module.
By default, the times-
A note emphasizes or supplements tamp is in universal
important points of the main text. A time format, L
Note . . . . :
note provides information that may This can be changed in
apply only in special cases. the Driver Log Filters
dialog box.
A tip suggests alternative methods
that may not be obvious in the user
Tip interface. A tip also helps the user in
working more effectively with IGSS.
A tip is not essential to the basic
understanding of the text.
A warning is an important note that is If you disregard the
essential for the completion of a System alarm, you
Warning task. In some cases, disregarding a may risk loss of data
warning may result in undesirable in the and
functionality or loss of data. files.

3.2 Getting Help in IGSS

IGSS comes with a comprehensive help system designed to help both system designers and operators to
get started with IGSS as quickly as possible.

Documentation overview

lyniversal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in
most parts of the world. IGSS uses this time format internally in the database. You can switch between UTC
and local time by enabling or disabling the "UTC" field in various dialog boxes in the system.




IGSS V8, User Guide

The IGSS documentation includes the following items:

Documentation item Description

An introduction to IGSS and its most fundamental terms and features.
Getting Started is intended to get you up and running as fast as pos-
sible. The manual provides a system and architecture overview fol-
lowed by a number of real-life use cases you can go through before
building your first real IGSS project. The manual is available in Adobe
Acrobat format (.pdf).

Getting Started

For each module there is a help file with the same name as the module
itself, for example, Igss.chm for the Master module, Igss.exe.

Module help The help file is invoked by clicking the ¥ in the upper right corner of
the module. The Table of Contents will then allow you to browse
through the topics.

For each dialog box there is a help topic with the following standard
information:

Overview
Preconditions
Where do I find it?
Field help

Dialog box help

Dialog box help is invoked by clicking the help button @ in the upper
right hand corner of the dialog box.

IGSS also provides thematic help. When there is a special theme that
requires special attention from the user, a dedicated help file is pro-
vided. Examples include "Driver-Specific Help" and "Database Admin-
istration Help".

Thematic help

Where are the help files located?

The IGSS help files are located in the appropriate language folder under the [IGSS InstallPath]. The help
files are available in English at release time.

The paths to the help files are:

Language Path
English [IGSS InstallPath]\ENG
Danish [IGSS InstallPath]\DAN
German [IGSS InstallPath]\DEU

Translated help files

-10 -
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Selected help files have been translated into Danish and German. If you require help files in your language,
please contact 7T.

Help updates

The IGSS help files are continuously updated and improved. Check regularly with the IGSS Update mod-
ule in the IGSS Start menu.

3.3 Version Information (IGSS Help System)
© 7-Technologies A/S, IGSS Version 8.0

The IGSS help files are based on software build number 9212 (initial release)

English help files

To update the help files, you must activate the IGSS Update module in the IGSS Start menu. There must
be a connection from the PC to the Internet. Every time IGSS Update is run, IGSS help files as well as
IGSS system files will automatically be updated on the PC from the 7-Technologies web server.

You select the languages you want to update in the Tools menu of the IGSS Update module.

If you are not able to update the IGSS system directly via the Internet, the alternative is to download the
updates from the 7-Technologies website as zip files. These can then be transferred onto a CD or USB mem-
ory stick, which is then the medium used to update on site.

After running , the build numbers in var-
ious IGSS modules may change to a higher nhumber.
This signifies that the module in question has been
updated with newer files. Build numbers consist of four

digits, where the first digit represents the year and the
last three represent the day number in the yearin ques-
tion. The build number can be seen in the About dialog
box which can be activated from the Help menu.

An example:

Build number = 9212
9 = the year 2009
210 = The 210th day of the year

-11 -
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Chapter 4: Glossary

A

Application button
The Application button, nicknamed "doughnut", is located in the upper left corner of the module's
window. Click the button to access the application menu. The menu contains items that were typ-
ically found in the File menu in previous versions of IGSS. In most modules, an "Options" item
allows the user to define global module settings. The Application button is a new term introduced
with the .NET platform and used in, for example, the Microsoft Office 2007 package.

atom

H

HDM
HDM is the abbreviation for Hour-Day-Month.

Q

Quick Access Bar
You can customize the Quick Access Bar to include the functions you use most frequently. Simply
drag the relevant function from the ribbon to the Quick Access Bar.

R

Ribbon
The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the well-known
toolbars in applications. The Ribbon provides quick access to the most commonly used functions
in the application. The Ribbon is divided into logical groups (the tabs) and each tab is divided into
sections (the blocks in the tab). The Ribbon is context-sensitive which means that only relevant
functions are accessible dependent on the current user action.

S

SCADA
Supervisory Control & Data Acquisition

U

UTC

Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating
time in most parts of the world. IGSS uses this time format internally in the database. You can
switch between UTC and local time by enabling or disabling the "UTC" field in various dialog boxes
in the system.

-12 -
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